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Front Back

Envelope  Make a wrap-around label

This intriguing variation of a standard mailing label wraps around to the back.

What a fun idea! This clever, wrap-around label arrived in our mailbox affixed 
to an invitation, and we were immediately smitten. Mailing and return addresses 
are both on a single, artistic strip that’s fun to design and efficient to print. It’s 
inexpensive, too, and ideal for use on colored envelopes. 

Because it’s non-standard, the post office will not love you, so it’s probably best 
for small-batch use like invitations rather than handwritten envelopes—no massive, 
corporate mailings, please. Our label was 63⁄4” x 11⁄2”; size yours proportionately.

For artwork, try patterns, textures and even photos.

Make sure that the 
backside “tab” and 
return address are 
very small to avoid 
being mistaken for 
the mailing address.

Mike & Judy Smith
74925 Chatterly Road
Columbus, OH 43215

The Parkers 

719 Almond Lane 

Elk Grove, CA 

95624
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Layout  Designing without bleeds

Guitar
An Illustrated Guide to Getting the Best 

Sound and Feel From Your Guitar

MARTIN BOWMAN

Guitar
An Illustrated Guide to Getting the Best 

Sound and Feel From Your Guitar

MARTIN BOWMAN

Print area Scale image to edge

Set guides Place content inside
Create a smaller “page” If a narrow, unprinted margin doesn’t suit your design 
style, try this. Create a smaller, artificial “page” inside the real one, then extend your 
photographic object beyond it. The wide margin no longer feels like a border (its 
width “disconnects” it from the page), and the breakout object adds depth. For more 
on designing without bleeds, see article 0609 (left).

AfterBefore

“I’m working on a tight budget that won’t allow bleeds, let alone color. I try to avoid 
this, but should I just make a white border around the image?” | Elijah Park

Guitar
An Illustrated Guide to Getting the Best 

Sound and Feel From Your Guitar

MARTIN BOWMAN
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Image  Tall image on a wide page

Cropping doesn’t always work (Left) A vertical image can 
often, but not always, be cropped horizontally. In this case, crop-
ping not only loses the energy of the high-flying dancer, we 
can’t even tell what he’s doing! Now what?

Before After

Soften the edge Fill the background with a color eye -
droppered from the image, then feather the edges of the photo. 
It’s still a vertical image, but it now looks spotlighted, not just 
pasted on. Note how much wider the slide looks.

“Horizontal images fit horizontal slides perfectly. But what if I have a tall image and 
want to go full screen? Can this be done without losing part of it?” | Karen Vogel

|  Page 1 of 2
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Variation 1 | Sky-color gradient Variation 2 | Blurred image

Blur. Scale to fit. Paste original on top.

Different techniques 
work with different 
 photos. The thing 
to remember is to 
tie photo and back-
ground in some way, 
usually with a com-
mon color. 

Apply a gradient.Sample a color. Two-tone photo? Try 
both colors.

Page 2 of 2
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“I have come across something that is of great interest to me. On the 
first page of article 0652, you show a 3-D image of the booklet cover 
and an open spread. How did you achieve the effect?” | Georgi Kalchev

Article 0652 is about designing a panoramic booklet. For the article cover, we wanted to show 
the physical booklet. Rather than show an actual printed piece, we chose to create an illusion 
using Photoshop CS3’s Warp tool. The cover above is slightly different from the one featured in 
the article, but the steps are the same. Here’s how we did it . . .

Photoshop  From flat to dimensional

  From flat . . .

|  Page 1 of 4

      . . . to dimensional   
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(1) Make a template (A) In 
your layout program, open a blank 
page the size of your booklet 
cover. Draw a grid of nine equal 

parts, then print the page. (B) Place the print 
on a flat surface (here, we used a large piece of 
cardboard), and tape the binding side. (C) Trace it. 
(D) Have someone lift the page to your desired 
curl, so you can take a picture (inset).

(2) Open in Photoshop Open the picture in 
Photoshop. Double-click the Background layer 
to unlock it, name it Template, and click OK. 
Next, bring in your cover image, and name its 
layer Cover. Next, lower the cover’s opacity in 
order to see the template grid below.

A

B
C

D

(3) Warp the cover image With 
the cover layer selected, go to 
Edit>Transform>Warp. You’ll notice 
that Photoshop has divided your 
image into nine equal 
parts (above). Posi-
tion the cover’s grid 
over the template by 
clicking-dragging inside 
a box, its corners, edges 
and handles (right). Click 
Enter to apply the warp.

Cover

Page 2 of 4
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Page 3 of 4

(4) Add the underlying page, and distort  
Add a Temporary Background layer above the 
Template layer, and fill with a gray background. 
Paste the underlying page below the Cover layer. 
Go to Edit>Transform>Distort. (Below) Using the 
tracing from Step 1 as a guide, drag each corner. 
Note: You’ll have to eyeball the top-right corner.

(5) Add more pages To create the illusion of 
additional pages, you’ll need to add thickness to 
the booklet. Add a More Pages layer below the 
Underlying Page layer. Using the Pencil tool (below), 
draw multi-colored lines, and position as shown.

(6) Add a shadow between the two pages 
Create a new layer above the Underlying Page 
layer. With black as the foreground color, select 
a large soft brush, and draw an angled shadow 
as shown below. Next, Option-Click (PC: Control-
Click) to mask the shadow.

Option-Click between
the two layers 

Note the shadows 
and staple

Position underneathDraw multi-colored lines

8 of 11
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(1) Open your spread in Photoshop Double-click the Background  
layer to unlock it, name it Master Spread, and click OK. Go to Image> 
Canvas Size, and increase the height and width as shown above. Using 
the Rectangular Marquee Tool (above), click-drag to make a selection . . .           

. . . . over the right page. Duplicate this page (Layer>New>Layer), and 
name it Right Page. (2) Distort the page Add a Temporary Back-
ground layer (above). Next, go to Edit>Transform>Distort. Grab the 
two right corners, and move down and over as shown above.

(4) Mask the shadows One by one, 
where all four arrows are pointing (left), 
Option-Click (PC: Control-Click) to mask 
the shadows. Reduce the shadow’s 
opacity to the percentages shown above.

(3) Add shadows On separate layers, 
you’ll need to create shadows A, B, C 
and D as shown above. (Left) Note that 
the spine shadow (A) is duplicated—
one goes above the Right Page layer, 
and one goes below. 

A 
B 
C

D 
A

A

B C

D

Move down 
and over.

Spread

45%

5%35%

35%
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Typefaces

1 Luxury Royale JF | 170 pt

2 (a–b) Futura Medium | a) 17.5/25 pt  
b) 17.5 pt 

3 ITC Franklin Gothic Book Condensed 
9.8/14.5 pt

4 Utopia Regular | 12/16.5 pt

Images

Images: iStockphoto.com

5 (255532)

6 (4417809)

7 (3542258)

8 (5479457)

Article resources  

Colors
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Before & After magazine  
Before & After has been sharing its practical approach 
to graphic design since 1990. Because our modern world 
has made designers of us all (ready or not), Before & 
After is dedicated to making graphic design understand-
able, useful and even fun for everyone.  

John McWade Publisher and creative director
Gaye McWade Associate publisher
Dexter Mark Abellera Staff designer
 
Before & After magazine
323 Lincoln Street, Roseville, CA 95678 
Telephone 916-784-3880 
Fax 916-784-3995
E-mail mailbox@bamagazine.com  
www http://www.bamagazine.com

Copyright ©2008 Before & After magazine 
ISSN 1049-0035. All rights reserved 

You may pass along a free copy of this article to others 
by clicking here. You may not alter this article, and you 
may not charge for it. You may quote brief sections  
for review; please credit Before & After magazine, and  
let us know. To link Before & After magazine to your 
Web site, use this URL: http://www.bamagazine.com. 
For all other permissions, please contact us.

Subscribe to Before & After

Subscribe to Before & After, and become a 

more capable, confident designer for pennies 

per article. To learn more, go to  

http://www.bamagazine.com/Subscribe

E-mail this article

To pass along a free copy of this article to 

others, click here.

Join our e-list

To be notified by e-mail of new articles as  

they become available, go to  

http://www.bamagazine.com/email
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Back   |     Paper-saver format

For paper-saver format  
Print: (Specify pages 13–18)

For presentation format  
Print: (Specify pages 1–11)

Print 
Format: Landscape  

Page Size: Fit to Page

Save
Presentation format or  

Paper-saver format

Before & After is made to fit your binder

Before & After articles are intended for permanent reference. All are titled and numbered.  

For the current table of contents, click here. To save time and paper, a paper-saver format of this article, 

suitable for one- or two-sided printing, is provided on the following pages.

http://www.bamagazine.com/Articles.asp?ID=149
http://www.bamagazine.com
http://www.bamagazine.com
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d
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T
h

is in
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d
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ailin
g lab

el w
rap
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n
d

 to
 th

e b
ack.

W
h

a
t a

 fu
n

 id
e

a
! This clever, w

rap-around label arrived in our m
ailbox affi xed 

to an invitation, and w
e w

ere im
m

ediately sm
itten. M

ailing and return addresses 
are both on a single, artistic strip that’s fun to design and effi cient to print. It’s 
inexpensive, too, and ideal for use on colored envelopes. 

B
ecause it’s non-standard, the post offi ce w

ill not love you, so it’s probably best 
for sm

all-batch use like invitations rather than handw
ritten envelopes—

no m
assive, 

corporate m
ailings, please. O

ur label w
as 6

3⁄4” x 1
1⁄2”; size yours proportionately.

For artw
ork, try patterns, textures and even photos.
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P
rint area

Scale im
age to edge

Set guides
P

lace content inside
C

re
a

te
 a

 sm
a

lle
r “p

a
g

e
” If a narrow

, unprinted m
argin doesn’t suit your design 

style, try this. C
reate a sm

aller, artifi cial “page” inside the real one, then extend your 
photographic object beyond it. The w

ide m
argin no longer feels like a border (its 

w
idth “disconnects” it from

 the page), and the breakout object adds depth. For m
ore 

on designing w
ithout bleeds, see article 0609 (left).
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n’t allow
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h
ite b

o
rd

er aro
u

n
d

 th
e im

age?” | E
lija

h
 P

a
rk

G
uitar

A
n Illustrated G

uide to G
etting the Best 

Sound and Feel From
 Your G

uitar

M
A

RTIN
 BO

W
M

A
N

3
 of 11

D
esign

 talk

®

D
e

sig
n

 talk
   

0673
 4

 of 11   

B
A

m
ag

azin
e.co

m
B

efo
re&

A
fter 

U
i

X

Im
age  Tall im

age on
 a w

id
e p

age

C
ro

p
p

in
g

 d
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e
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’t a
lw

a
ys w

o
rk

 (Left) A
 vertical im

age can 
often, but not alw

ays, be cropped horizontally. In this case, crop-
ping not only loses the energy of the high-fl ying dancer, w

e 
can’t even tell w

hat he’s doing! N
ow

 w
hat?

B
e

fo
re

A
fte

r

S
o

fte
n

 th
e

 e
d

g
e

 Fill the background w
ith a color eye -

droppered from
 the im

age, then feather the edges of the photo. 
It’s still a vertical im

age, but it now
 looks spotlighted, not just 

pasted on. N
ote how

 m
uch w

ider the slide looks.

“H
o

rizo
n

tal im
ages fi t h

o
rizo

n
tal slid

es p
erfectly. B

u
t w

h
at if I h

ave a tall im
age an

d
 

w
an

t to
 go

 fu
ll screen

? C
an

 th
is b

e d
o

n
e w

ith
o

u
t lo

sin
g p

art o
f it?” | K

a
ren

 V
ogel
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4
 of 11

D
esign

 talk

http://www.bamagazine.com/


®

D
e

sig
n

 talk
   

0673
 5

 of 11   

B
A

m
ag

azin
e.co

m
B

efo
re&

A
fter 

U
i

X

V
a

ria
tio

n
 1 | S

k
y-co

lo
r g

ra
d

ie
n

t
V

a
ria

tio
n

 2 | B
lu

rre
d

 im
a

g
e

B
lur.

Scale to fi t.
Paste original on top.

D
ifferent techniques 

w
ork w

ith different 
 photos. The thing 
to rem

em
ber is to 

tie photo and back-
ground in som

e w
ay, 

usually w
ith a com

-
m

on color. 

A
pply a gradient.

Sam
ple a color.

Tw
o-tone photo? Try 

both colors.
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“I h
ave co

m
e acro

ss so
m

eth
in

g th
at is o

f great in
terest to

 m
e. O

n
 th

e 
fi rst p

age o
f article 0652, yo

u
 sh

ow
 a 3-D

 im
age o

f th
e b

o
o

klet cover 
an

d
 an

 o
p

en
 sp

read
. H

ow
 d

id
 yo

u
 ach

ieve th
e effect?” | G

eorgi K
a

lch
ev

A
rticle 0652 is about designing a panoram

ic booklet. For the article cover, w
e w

anted to show
 

the physical booklet. R
ather than show

 an actual printed piece, w
e chose to create an illusion 

using P
hotoshop C

S3’s W
arp tool. The cover above is slightly different from

 the one featured in 
the article, but the steps are the sam

e. H
ere’s how

 w
e did it . . .

Photoshop  From
 fl at to d

im
en

sion
al

  Fro
m

 fl a
t . . .
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(1) M
a

k
e

 a
 te

m
p

la
te

 (A
) In 

your layout program
, open a blank 

page the size of your booklet 
cover. D

raw
 a grid of nine equal 

parts, then print the page. (B
) P

lace the print 
on a fl at surface (here, w

e used a large piece of 
cardboard), and tape the binding side. (C

) Trace it. 
(D

) H
ave som

eone lift the page to your desired 
curl, so you can take a picture (inset).

(2) O
p

e
n

 in
 P

h
o

to
sh

o
p

 O
pen the picture in 

P
hotoshop. D

ouble-click the B
ackground layer 

to unlock it, nam
e it Tem

plate, and click O
K

. 
N

ext, bring in your cover im
age, and nam

e its 
layer C

over. N
ext, low

er the cover’s opacity in 
order to see the tem

plate grid below
.

A

B
C

D

(3) W
a

rp
 th

e
 co

ve
r im

a
g

e
 W

ith 
the cover layer selected, go to 
Edit>

Transform
>

W
arp. You’ll notice 

that P
hotoshop has divided your 

im
age into nine equal 

parts (above). P
osi-

tion the cover’s grid 
over the tem

plate by 
clicking-dragging inside 
a box, its corners, edges 
and handles (right). C

lick 
Enter to apply the w

arp.

C
o

ve
r
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Life in slow motion.
Four days, three nights, $450
www.travelblue.net
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(4) A
d

d
 th

e
 u

n
d

e
rlyin

g
 p

a
g

e, a
n

d
 d

isto
rt 

A
dd a Tem

porary B
ackground layer above the 

Tem
plate layer, and fi ll w

ith a gray background. 
Paste the underlying page below

 the C
over layer. 

G
o to Edit>

Transform
>

D
istort. (B

elow
) U

sing the 
tracing from

 Step 1 as a guide, drag each corner. 
N

ote: You’ll have to eyeball the top-right corner.

(5) A
d

d
 m

o
re

 p
a

g
e

s To create the illusion of 
additional pages, you’ll need to add thickness to 
the booklet. A

dd a M
ore Pages layer below

 the 
U

nderlying Page layer. U
sing the P

encil tool (below
), 

draw
 m

ulti-colored lines, and position as show
n.

(6) A
d

d
 a

 sh
a

d
o

w
 b

e
tw

e
e

n
 th

e
 tw

o
 p

a
g

e
s 

C
reate a new

 layer above the U
nderlying Page 

layer. W
ith black as the foreground color, select 

a large soft brush, and draw
 an angled shadow

 
as show

n below
. N

ext, O
ption-C

lick (P
C

: C
ontrol-

C
lick) to m

ask the shadow
.

O
ption-C

lick betw
een

the tw
o layers 

N
ote the shadow

s 
and staple

P
osition underneath

D
raw

 m
ulti-colored lines
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A
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U
i

X

(1) O
p

e
n

 yo
u

r sp
re

a
d

 in
 P

h
o

to
sh

o
p

 D
ouble-click the B

ackground 
layer to unlock it, nam

e it M
aster Spread, and click O

K
. G

o to Im
age>

C
anvas Size, and increase the height and w

idth as show
n above. U

sing 
the R

ectangular M
arquee Tool (above), click-drag to m

ake a selection . . .           

. . . . over the right page. D
uplicate this page (Layer>

N
ew

>
Layer), and 

nam
e it R

ight Page. (2) D
isto

rt th
e

 p
a

g
e

 A
dd a Tem

porary B
ack-

ground layer (above). N
ext, go to Edit>

Transform
>

D
istort. G

rab the 
tw

o right corners, and m
ove dow

n and over as show
n above.

(4) M
a

sk
 th

e
 sh

a
d

o
w

s O
ne by one, 

w
here all four arrow

s are pointing (left), 
O

ption-C
lick (P

C
: C

ontrol-C
lick) to m

ask 
the shadow

s. R
educe the shadow

’s 
opacity to the percentages show

n above.

(3) A
d

d
 sh

a
d

o
w

s O
n separate layers, 

you’ll need to create shadow
s A

, B, C
 

and D
 as show

n above. (Left) N
ote that 

the spine shadow
 (A

) is duplicated—
one goes above the R

ight Page layer, 
and one goes below

. 

ABCDA

A

B
C

D

M
ove dow

n
and over.

S
p

re
a

d

45%

5%
35%

35%

C
lick . . . 

. . . drag

Page 4 of 4
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X

M
ike &

 Ju
d

y Sm
ith

74925 C
h

atterly R
o

ad
C

o
lu

m
b

u
s, O

H
 43215

The Parkers

719 Alm
ond Lane

Elk G
rove, CA 

95624

G
uitar

A
n Illustrated G

uide to G
etting the Best 

Sound and Feel From
 Your G

uitar

M
A

RTIN
 BO

W
M

A
N

Typ
e

fa
ce

s

1 Luxury R
oyale JF | 170 pt

2 (a
–b

) Futura M
edium

 | a) 17.5/25 pt 
b) 17.5 pt 

3 ITC
 Franklin G

othic B
ook C

ondensed 
9.8/14.5 pt

4 U
topia R

egular | 12/16.5 pt

Im
a

g
e

s

Im
ages: iStockphoto.com

5 (255532)

6 (4417809)

7 (3542258)

8 (5479457)

A
rticle

 re
so

u
rce

s  

C
o

lo
rs

C
30

 M
30

 Y
30

 K100

C
0

 M
0

 Y
0

 K55

910

910

7 6

2b
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1
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a
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B
efo

re &
 A

fter h
as b

een
 sh

arin
g its p

ractical ap
p

ro
ach 

to
 grap

h
ic d

esign
 sin

ce 1990. B
ecau

se o
u

r m
o

d
ern

 w
o

rld 
h

as m
ad

e d
esign

ers o
f u

s all (read
y o

r n
o

t), B
efo

re &
 

A
fter is d

ed
icated

 to
 m

akin
g grap

h
ic d

esign
 u

n
d

erstan
d

-
ab

le, u
sefu

l an
d

 even
 fu

n
 fo

r everyo
n

e.  

Jo
h

n
 M

cW
a

d
e

 P
u

b
lish

er an
d

 creative d
irecto

r
G

a
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e
 M
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 A
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r M
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Yo
u

 m
ay p

ass alo
n

g a free co
p

y o
f th

is article to
 o

th
ers 

b
y clickin

g h
ere. Yo

u
 m

ay n
o

t alter th
is article, an

d
 yo

u 
m

ay n
o

t ch
arge fo

r it. Yo
u

 m
ay q

u
o

te b
rief sectio

n
s 

fo
r review

; p
lease cred

it B
efo

re &
 A

fter m
agazin

e, an
d 

let u
s kn

o
w

. To
 lin

k B
efo

re &
 A

fter m
agazin

e to
 yo

u
r 

W
eb

 site, u
se th

is U
R

L: h
ttp

://w
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am
agazin
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. 
Fo

r all o
th

er p
erm
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s, p
lease co
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s.

S
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scrib
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 &
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Su
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 B
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d

 b
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m
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m
o
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n
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en

t d
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n
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p
er article. To
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o
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h
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w
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m

/Su
b

scrib
e

E
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ail th
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To
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n
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y o
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is article to
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th

ers, click h
ere.

Jo
in

 o
u
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 b

e n
o
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 articles as 
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